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Manual

1. Introduction

This document is intended as a guide to running KASP™ genotyping reactions on the  
ABi 7900 instrument. 
KASP chemistry for allelic discrimination performs well on an ABi 7900 machine and this step-by-step 
protocol will enable users to successfully set-up, run and read plates on the 7900. 

2. Tips and suggestions before you start

1.	 Optimal cycling conditions for KASP require a touchdown 2-step PCR protocol. The cycling 
conditions for most assays will be as described in this manual (section 4), although you must check 
the cycling conditions included in your assay information pack to ensure that your assay does not 
have any specific cycling conditions.

2.	 KASP is an end-point chemistry and will require a final read once the PCR amplification steps have 
been completed. Completed KASP reactions must be read below 40 °C. 

3.	 In the 7900 software (SDS), you must perform a pre-read (before the thermal cycle) and a post-
read (after the thermal cycle) on your reaction plate in order to obtain suitable genotyping data.

4.	 Data capture should not be performed during the thermal cycle program – no useful data will be 
captured as KASP chemistry cannot be read at these temperatures. Reading the plate throughout 
the thermal cycle will unnecessarily reduce the lifespan of your instrument’s laser.

5.	 The KASP recycling program will often will improve results, especially for assays that are slow  
to group. 

6.	 KASP is supplied with the HEX™ fluorophore but this has the same excitation and emission 
spectra as VIC; they are therefore interchangeable. The SDS software only has an option for 
programming with VIC so ensure that you use this for the HEX allele.

3. Overview of the procedure

1.	 Create an allelic discrimination (AD) file in the SDS 
software – see section 5.1. N.B. This file will be used to 
capture the pre-read and post-read data for your reaction 
plate, and to perform data analysis.

2.	 Create an allelic quantification (AQ) file in the SDS 
software. This file will be used to perform the KASP thermal 
cycle only – see section 5.2. 

3.	 Perform a pre-read of your reaction plate - see section 5.3.
4.	 Run the thermal cycle and subsequent plate read step for 

your sample plate – see section 5.3 and section 5.4.
5.	 Analyse the data – see section 5.5.
6.	 Recycle the plate if necessary – see section 5.6.
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4. KASP thermal cycling conditions

N.B. On the 7900, it is essential to perform a pre-read of your reaction plate in an AD file,  
before running the thermal cycle in an AQ file.

4.1	KASP thermal cycling conditions*

1.	 94 °C 15 minutes
2.	 94 °C 20 seconds
3. 	 61 °C 60 seconds (drop by - 0.6 °C/per cycle)
	 Repeat steps 2-3 9 times (a total of 10 cycles) achieving a final annealing temperature of 55 °C
4.	 94 °C 20 seconds
5.	 55 °C 60 seconds
	 Repeat steps 4-5 for 25 times (a total of 26 cycles)
6.	 Read plate at less than 40 °C

4.2	KASP recycling conditions

1.	 94 oC 20 seconds
2.	 57 oC 60 seconds
	 Repeat steps 1-2 twice (a total of 3 cycles)
3.	 Read plate at less than 40 oC

* KASP cannot be read at temperatures above 40 °C. Turn off data capture for each of the cycling 
steps as this is not necessary.
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5. Step-by-step user guide

For KASP end-point analysis on the ABI 7900 series you need to set up the following two files:

1.	 Allelic discrimination file (AD) that records the pre- and post-read fluorescence data
2.	 Allelic Quantification file (AQ) that holds the thermal cycling conditions

Both files are required but only the AD file requires set-up up for each run whilst the AQ file holds only 
the cycling conditions and can be set-up once and re-used for subsequent runs. 

To set up an AD file, please see section 5.1.
To set up an AQ file, please see section 5.2.

5.1	Set up an allelic discrimination (AD) file

•	 Open the SDS software
•	 Click on the ‘File’ menu, and click ‘New’. The 

‘New Document’ window will open. Choose ‘Allelic 
Discrimination’ and press ‘OK’.

•	 An AD file will open – this includes a plate layout 
view, a table view and a setup view.

•	 You will now need to define the marker(s) and the 
detector(s) for your experiment before proceeding:

	 •	 Marker: an identifier for your SNP  
	 (i.e. An individual KBD/KOD assay name)

	 •	 Detector: each marker has two detectors, one for the X allele and one for the Y allele  
	 (i.e. FAM™ and HEX)

•	 Click on the ‘Tools’ menu, and click ‘Detector Manager’ 
to open the Detector Manager window.
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•	 Click on the ‘New...’ button. The ‘Add detector’ box will come up.
•	 Fill in the details for your first detector i.e. one allele of a SNP
	 •	 Name – your chosen name
	 •	 Group – default
	 •	 Description – optional
	 •	 AIF Assay ID – optional
	 •	 Reporter – allele X reporter i.e. FAM
	 •	 Quencher – ensure that you set this to ‘Non Fluorescent’
•	 Click ‘OK’.
•	 Repeat the process for the second allele of your SNP. 
•	 N.B. The Reporter for the second allele will be ‘VIC’ (HEX 

is the second fluorophore used in KASP, but this is not an 
option in the SDS software. VIC and HEX can be read at the 
same wavelength.)

•	 Click on the ‘Tools’ menu and click ‘Marker Manager’ to open 
the ‘Marker Manager’ window. 

•	 Click ‘New’ and the ‘Marker Information’ box will come up.
	 •	 Name – give the marker a suitable name
	 •	 Assay ID – use a unique identifier
	 •	 Colour – click on this to change if desired
	 •	� Allele X – click on the button and choose the newly created 

FAM detector
	 •	� Allele Y – click on the button and choose the newly created 

HEX/VIC detector
		  N.B. For Alleles X and Y, you can fill in the base ID (i.e. A, T, C or G) if desired.
•	 Click ‘OK’ to return to the ‘Marker Manager’ screen. Your newly created marker will be added to 

the list. Click ‘OK’.
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•	 In the AD file main view, click on the ‘Add marker’ button at the centre-bottom 
of the screen.

•	 The ‘Marker Manager’ window will open. Select the marker(s) that you require for your 
experiment by highlighting them. Click on the ‘Copy to Plate Document’ button, and then click 
‘Done’ to return to the main AD file screen.

•	 In the plate layout view, highlight all the wells that you will be running this particular assay in. 
Click in the ‘Use’ box for the marker to add the assay information to the wells. The relevant wells 
will then show the colour of the marker that you have chosen. 

•	 In the table view, you can fill in the names for all of your samples if desired (the default name is 
well location i.e. A1, A2, A3).

•	 Highlight the wells that contain no-template controls (NTCs) for a particular assay (marker) and, 
in the setup tab, change the ‘Task’ for these wells from ‘Unknown’ to ‘NTC’.

•	 The AD file can now be saved.
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5.2 Set up an allelic quantification file (AQ)

•	 Click on the ‘File’ menu , and click ‘New’. The 
‘New Document’ window will open. Choose 
‘Standard Curve (AQ)’ and press ‘OK’.

•	 An AQ file will open – this includes a plate 
layout view, a table view and a setup view.

•	 Click on the ‘Instrument’ tab, followed by the 
‘Thermal Cycler’ tab within.

•	 The ‘Thermal Profile’ tab is where you can 
edit the thermal cycling conditions.

•	 Edit the default thermal cycle to the conditions 
required for KASP genotyping.
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Cycling conditions

Stage 1
1.	 94 °C 15 minutes

Stage 2
1.	 94 °C 20 seconds
2.	 61 °C 60 seconds. **Decrement -0.6 °C/per cycle** 
	 Set the decrement up using the ‘Auto Increment‘ tab. 
	 Repeat Stage 2 x 9 times (a total of 10 cycles) achieving a final annealing temperature of 55 °C.

Stage 3
1.	 94 °C 20 seconds
2.	 55 °C 60 seconds
	 Repeat Stage 3 x 25 times (a total of 26 cycles)

Stage 4
1.	 37 °C for 1 minute. This will bring the reaction plate to 

the correct temperature for reading the fluorescence 
(N.B. The read will be performed in the AD file, see 
section 5.5).
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•	 In the ‘Data Collection‘ tab, turn off all of the data collection steps as these 
are not necessary during the thermal cycle.

•	 This can be done by clicking on the data symbol to remove it. 
•	 Click on the ‘Add Detector’ button and select the two detectors (one for 

FAM and one for VIC/HEX) that you created earlier (see section 5.1).

•	 Click in the ‘Use’ box for the detector to add the information to the wells. The relevant wells will 
then show the colour of the detectors that you have chosen (N.B. Unless you expand the plate 
view to full-screen sized, you will only see the colour for one of the detectors). 

•	 The AQ file can now be saved. You can used this file for future runs as the alleles that have 
been defined do not need to be specific for each AQ file – the AQ file is only used to perform  
the thermal cycle and no data should be collected.
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5.3 Perform a pre-read (AD file)

•	 Open the AD file that you created in 
section 5.1

•	 Click on the ‘Connect’ button to connect 
your instrument to the AD file.

•	 Save the AD file with a name and a 
folder location that can be easily found 
later (you will need the file again for the 
post-read).

•	 Open the instrument and place your 
plate on the plate holder. Click on ‘Pre 
Read’. The instrument door will close 
and the pre read data will be collected.

•	 When the pre-read is complete, save 
the file.

•	 Tip: It is always a good idea to have a look at the raw data from the pre-read. All the wells 
should give a similar raw data plot, with the only fluorescent signal being that of ROX, the 
passive reference dye. 

5.4 Perform the thermal cycle (AQ file)

•	 Open the AQ file that you created in section 5.2 and ‘Save As’ an appropriate file name  
(N.B. You must save the file with a different name if you wish to keep using the original file for 
subsequent thermal cycle runs).

•	 Navigate to the ‘Instrument’ tab, and then the ‘Real-Time’ tab within.
•	 Click the ‘Connect to Instrument’ button. Once the connection is established, click ‘Start Run’.
•	 The thermal cycle will then run. The standard KASP protocol takes approximately 1.5 hours on 

the ABI 7900. 

Manual
Running KASP genotyping on the ABI 7900 instrument



12

5.5 	 Perform a post-read (AD file)

•	 Open the AD file that you performed the  
pre-read in. Essential: Click ‘Save As’  
and give the file a different name e.g.  
‘AD File_First post read’. If this is not done, 
further Post Read runs of the same plate  
will not be possible. 

•	 Click on the ‘Connect’ button to connect your 
instrument to the AD file.

•	 Click on ‘Post Read’. (N.B. Plates must be 
read at at less than 40 °C).

•	 When the post-read is complete, save the file.

5.6 	 Analysis of results

•	 Click on the ‘Analyse’ button at the top of the screen (green arrow/triangle) to perform 
analysis of the read data.

•	 The SDS software will then automatically call the 
results for the samples on your plate. If it cannot 
automatically call a sample, it will leave the data 
point as an X. 

•	 The plate layout should then contain coloured 
dots indicating samples for which the SDS 
software has been able to call a result, crosses 
(X) for samples that cannot be auto-called, 
and black squares for the wells that have been 
defined as no-template controls (NTCs).

•	 The crosses can often be called manually during 
the analysis phase.

•	 TIP: All automatically called samples should 
be checked manually as the SDS software can 
sometimes call samples incorrectly.

•	 On the right-hand side of the screen, click on 
the ‘Results’ tab. N.B. If the Results tab is not 
there, the data has not been analysed. The 
Results tab enables you to look at the allelic 
discrimination plots.

•	 Add the raw data viewer to your screen by 
clicking on this symbol.
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•	 Use the AD plot and the raw data plots to help you to assign calls to each of the DNA samples.
•	 As a brief guide, the following raw data plots indicate these genotypes:

Allele X
Peak around 6 on the X axis

Allele Y 
Peak around 11/12 on the X axis

Heterozygous  
(both alleles) 
Signal across 5-15 on the X axis

•	 The auto-caller settings can be edited. In the ‘Analysis’ menu, select ‘Analysis Settings’. The 
‘Plate’ tab enables you to adjust the settings for cluster calling. The ‘Marker’ tab enables you to 
select ‘2-cluster calling enabled’ that will allow monomorphic allele populations to be auto-called.  
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5.7 	 Recycling your assay plate

•	 If your data has not formed tight clusters 
after the initial thermal cycling protocol, 
you can recycle the plate in the ABI 7900 
(or on a Peltier block) and perform a 
second post-read.

•	 You will need to create an AQ file with 
the thermal cycling conditions for KASP 
recycling conditions (see section 5.2).

•	 The KASP recycling conditions are:
		  1.	 94 °C for 20 seconds
		  2.	 57 °C for 60 seconds
	 Repeat steps 1 - 2 (Stage 1) twice (a 

total of 3 cycles).
	 Add a second stage at 37 °C for 1 

minute to bring the plate to the correct 
temperature for reading.

•	 Once the recycling thermal cycle has 
finished, you will need to perform a 
second plate read.

•	 Open the original AD file that contains the pre-read data only. Essential: Click ‘Save As’ and give 
the file a different name e.g. ‘AD File_Second post read’. If this is not done, further Post Read 
runs of the same plate will not be possible. 

•	 Perform the post-read (see section 5.5) and analyse the new data (see section 5.6).
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5.8	 Running the KASP trial kit on the ABI 7900

•	 If you have requested a KASP trial kit to 
run on your ABI 7900 instrument, please 
follow the protocol included with the kit 
to set up your reaction plate. This ABI 
7900 manual can be used to help you to 
programme the instrument to run the trial 
kit reaction plate.

•	 After the initial KASP thermal cycle, the 
trial kit reaction plate should produce data 
similar to the figures below.

6. Further support

For any queries about this manual, please 
contact techsupport@lgcgroup.com.
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